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Welcome to TeachUcomp, Inc.’s Mastering Outlook

Made Easy for Lawyers CPE Edition v.2.0 tutorial. This

course will delve into topics that are useful for legal

professionals to know when using Microsoft Outlook. The

purpose of the course is to better inform and educate legal

professionals in the industry-specific issues and concerns

that arise from the use of Microsoft Outlook in a legal

setting. This class also requires advanced knowledge of

the Microsoft Outlook program. Therefore, it is

recommended that you familiarize yourself with the content

of TeachUcomp, Inc.’s Mastering Outlook Made Easy

tutorial, which is included within this product, prior to

learning the CPE (Continuing Professional Education) part

of the tutorial that is included within this manual and which

focuses on aspects of the program used by lawyers At the

end of the course the student should have a better

understanding of the problems that can arise and solutions

that are available when you use Outlook as a legal

professional.
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Managing Mail

16.1- Using Subfolders:

Many attorneys find that they receive a substantial amount of daily e-mail. In this chapter we will

discuss many mail management techniques that have been found to be effective in categorizing, sorting,

and clearing a cluttered mailbox. The first technique that we will discuss is the use of subfolders within an

Inbox. While some feel that this is a deprecated technique that is not as efficient as using the newer Search

folders within Outlook, it is still worth knowing how to perform. Many lawyers will create subfolders for their

individual cases and then sort their incoming email into the desired folder manually or by using email rules

that they create. You can choose to create subfolders for clients, cases, projects or whatever convention

makes the most sense for your particular organization. However you choose to use this feature, you will

need to know how to create a subfolder within your Inbox before it can be of any use.

One way to create a subfolder is to right-click the Inbox within the Folder Pane in Outlook, and then

select the “New Folder” command from the pop-up menu that appears. A new folder will then be added to

the Folder Pane beneath the Inbox. In Outlook 2013, you simply need to type a name for the new folder and

then press the “Enter” key on your keyboard to create the new subfolder of the Inbox. If using Outlook 2010-

2007 instead, then the “Create New Folder” dialog box opens. Here you enter the name of the folder into

the “Name:” text box and then click the “OK” button.

If you happen to make a mistake when naming the subfolder, you can rename a subfolder that you

have created by right-clicking the desired subfolder and then selecting the “Rename Folder” command from

the pop-up menu that appears. You can then proceed to type the desired folder name and press the “Enter”

key to set the name when you have finished.

Also note that you have a great deal of control over where you place your folders and what types of

items they can contains by default. If you wish to learn more about creating folders within your Outlook

account, please review lesson “11.3- Creating Private Folders” in the “Advanced Outlook” manual within the

Mastering Outlook Made Easy™ for Lawyers tutorial.

Once you have created subfolders, you can manually move any associated mail, appointments,

tasks, or other Outlook items you receive into the designated subfolder when they arrive in your Inbox. To

do this, select the Inbox within the Folder Pane to display the email within the Inbox. Then click and drag

the email you want to move, and drop it onto the desired subfolder within the Folder Pane.

16.2- Using Mailbox Rules to Organize Mail:

If you have subfolders within your Inbox, you can create mailbox rules that will move mail to the

subfolders when it is received in your Inbox if it contains specific text in the message subject or body. This

reduces the amount of time it takes to manually sort and organize your Inbox and its subfolders.

If you need to review the process of creating folder rules, you should review lesson “13.1- Creating

Mailbox Rules” in the “Advanced Outlook” manual within this product. Note that you can apply rules to

folders that you create, as well as your Inbox within Outlook. To create rules in Outlook 2013:2010, click the

“Rules” button in the “Move” group on the “Home” tab in the Ribbon, and then select the “Manage Rules &

Alerts…” command. To create rules in Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar.

In all versions of Outlook at that point the “Rules and Alerts” dialog box will appear. Ensure that you

are viewing the “Email Rules” tab, and then click the “New Rule…” button in the upper left corner of that tab

to launch the “Rules Wizard.”

At this point, you simply need to create a new rule that states that mail that arrives in your Inbox that

contains words in either the body or subject that pertain to a selected matter or case should be immediately

moved to the designated folder that you have already created.Sa
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Managing Mail

16.3- Using Search and Search Folders to Organize Mail:

Many efficiency studies have pointed out that using the “Search” and “Search Folders” features

within your Inbox is a much faster and more efficient way to sort and organize your email versus using

subfolders. Using this technique, you do not create subfolders. All mail is collected within your Inbox.

However, you then use the “Search” feature, as well as create specific “Search Folders,” to selectively filter

the Inbox to display only the mail items you wish to see at that time. Let’s examine how the “Search

Folders” feature works within Microsoft Outlook.

To create a new search folder, right-click the “Search Folders” icon within the “Mail” section of the

Folder Pane and then select the “New Search Folder…” command from the pop-up menu that appears. In

the “New Search Folder” dialog box that appears, you can then select the criteria by which you want to find

mail. Just as when creating mailbox rules, you can find mail by sender, mail status, or find specific words in

the subject line or body of the email. To create your own criteria, select the “Create a custom Search

Folder” choice to open the “Search Folder Criteria” dialog box where you can define any and all search

criteria you wish to apply to your search folder. Once you have created your criteria, simply click the “OK”

button to create your new Search Folder.

To use the Search Folder, simply click it in the Folder Pane to display all of the items within your

Inbox that match the search criteria specified. You can then click your Inbox folder again to display all

messages.

Separately from creating a more permanent Search Folder, if you want to find a particular piece of

mail within your Inbox, you can simply do a quick search to find it. To do this, select the Inbox folder and

then type the word or words for which you are searching into the “Search” text box that appears above the

folder. Outlook will then filter the Inbox to display only messages that contain the text for which you are

searching. You can then click the small “x” button that appears at the right end of the “Search” text box to

clear the search terms and display all of the messages in your Inbox again when you are finished.

16.4- Making Mail Easier to Search:

One of the quickest ways to search for email is by searching for text within the “Subject” line of the

email. This allows Outlook to skip scanning the body text of the actual email, thereby allowing for faster and

easier searching. In this lesson, we will examine changing the “Subject” line of email you receive so you can

add text that will allow you to find the email more quickly in the future.

To edit the subject line of an email you have received, double-click the message within your Inbox to

open the email in its own message window. At that point, make any changes that you want to the subject

line displayed within the email. This is the point at which you would want to add the text that will categorize

the email. Then click the “Save” button within the Quick Access toolbar and accept any warning messages

that Outlook may show you. Note that you cannot change the subject line of an email that contains an

attachment while the attached file is opened. You must first close the attached file before editing the subject

line of the associated email.

Also, in Outlook 2013:2010, which shows email sorted by conversation by default within the Inbox,

you may notice that changing the subject line doesn’t change the way that the email is grouped and

displayed in conversation view. This is because conversation view uses the “conversation” field to organize

the mail- not the “subject” field. If you wish to disable the conversation view, you can do so by clicking the

“View” tab in the Ribbon and the unchecking the “Show as Conversations” option when the Inbox is

selected. Alternately, you could also right-click in the message headers shown within the message list

shown in the Inbox folder, and then select the “Show as Conversations” option to uncheck it.Sa
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Managing Mail

16.5- Managing Reminders:

You can use the “Flag for follow up” feature along with reminders in Outlook to aid you in

remembering the tasks and other activities you need to complete, as well as when you must complete them.

To review setting message flags as well as reminders on Outlook emails, review lesson “3.3- Message

Flags” in the “Introductory Outlook” manual included with this product.

Once you have a system in place for noting reminders, however, you may find that you will have

several reminders appearing in the “Reminders” window as the items that are flagged for follow-up come

due. You have several options for dealing with the reminders that appear in the “Reminders” window. Note

that while you can select each item and set a “Snooze” time individually, if you have several reminders

appearing within the window you can also select multiple reminders first and then set the same “Snooze”

time for all of the selected reminders. Selecting multiple items in the “Reminders” window is just like making

multiple selections in other windows, simply click on the first item, hold down the “Shift” key and then click

the last item to select those items and all items between them.

Also, for items that you have already completed, you can mark them as completed in the

“Reminders” window one at time without having to open each item individually. To do this, simply right-click

on the desired item within the “Reminders” window, and then select the “Mark Complete” option from the

pop-up window that appears. Note, however, that you can only mark one item at a time as completed. The

option to “Mark Complete” will not appear if you right-click on multiple selected reminders within the

“Reminders” window.

16.6- Saving Email as PDF:

In the new era of mobile technology, it can be frustrating to not have access to your email on your

mobile devices. For example, sometimes you cannot read a PC-based Outlook email message that has

been saved through a web-based service on your tablet in its native Outlook email format. In this situation,

saving the relevant email as a PDF file that you can access through a web-based service on your mobile

tablet device can be helpful to lawyers who need access to their files on the go.

Outlook does not support native PDF printing for its email in the PC versions of the software. If you

wish to save an email as a PDF using the PC version, you can install a third-party solution of your choosing.

There are several free PDF creators and converters available on the Internet. Once you have this software

installed on your PC, you can then open your email message and select the “Print” command. In the “Print”

dialog box that appears, select the “PDF Converter” option (based on the conversion software you

acquired) from the “Printer” drop-down choice when you have the email opened. You can then select the

desired folder to which you want to save the resultant PDF file once you click the “OK” button to print the

email. Once you have created these files, you can then upload them to whatever remote web-based service

you use to get files for your tablet.
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Managing Mail

16.7- Turning Emails into Tasks:

You can easily turn an email you receive into a task, thereby preserving the text of the email and any

phone numbers or other information it contains as an actionable task for which you can then set a reminder

date, as well as other task information. To do this, click and drag the desired email onto your “Tasks” folder

within the Folder Pane. When you release the mouse button, Outlook will convert the email into a task and

display the content within a task window where you can then set associated task information, such as a

reminder date, a due date, or task category. Once you have finished creating the task, simply click the

“Save & Close” button in the Ribbon or toolbar within the “Task” window to save it.

16.8- AutoReply to Email:

The AutoReply feature of Outlook can be indispensable for attorneys who must make many court

appearances and travel to perform their jobs. Whenever you must leave the office for a day, it is a good

habit to set an AutoReply to email- informing people that you are out of the office and when you can be

expected to return.

As long as you have an Exchange Server email account, then you can enable an “Out of office”

AutoReply in Outlook 2007 by selecting “Tools| Out of Office Assistant…” from the Menu Bar. Then enter

the text that you would like to use as your out of office message. You can then enable the feature by

selecting the option button that says “I am currently Out of the Office.” Then click the “OK” button to finish.

At that point, all people who send you an email will receive a message informing them that you are out of

the office. When you return to the office, open the Out of Office Assistance again, and this time select the “I

am currently In the Office” option button to disable the feature.

Note that this feature changes in Outlook 2013:2010, and is available by clicking the “File” tab in the

Ribbon, and then the “Info” button in the backstage view. Then select the “Automatic Replies (Out of Office)”

button. In the “Automatic Replies” dialog box that opens, check the “Send Automatic Replies” checkbox.

You can then specify a duration for the automatic replies, if needed. Next, type the message that you want

to have appear for users on both the “Inside my organization” and “Outside my organization” tabs. Then

click the “OK” button to enable the automatic replies. If you specified a duration, Outlook will stop sending

auto replies when the duration expires. Otherwise, simply return to the “Automatic Replies” dialog box and

select the “Do not send automatic replies” checkbox and then click the “OK” button.

Note that if you do not have an Exchange Server account configured in your Outlook profile, you can

still emulate this feature by using an email template that you create in conjunction with the mailbox rules. To

do this, first create a plain text email message and type whatever you want your out of office reply to be as

the body of the email message. Then select the “Save As” command within the message window. You can

then name the message whatever you want, but be sure to save the file as the file type of “Outlook

Template” by using the “Save as type” drop-down. Then click the “Save” button to save the new email

template. You can then select your Inbox and create a new rule for the Inbox using the “Rules Wizard.” If

you need to review creating mail box rules, please read lesson “13.1- Creating Mailbox Rules” in the

“Advanced Outlook” manual within this product. When you create the rule, ensure that the rule will be

triggered when the condition is set to mail that is received by you. Then set the action to be reply using a

template. You can then edit the rule and select the email template that you just created as the email

template to use. You can then finish the rule as you normally would, and click the “Finish” button when you

are done. You can then enable and disable the rule, as needed, in order to send an “Out of Office” reply to

received email by using the mailbox rules on your non-Exchange email account.Sa
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Managing Mail

16.9- Autoforwarding Email:

If you do not have the ability to access your Outlook emails remotely, then another useful feature for

lawyers is the ability to have Outlook automatically forward email you receive to another email account you

can access from your mobile devices. This way, you can still check your email when traveling or when you

have a free moment when in court. You can set up automatic forwarding on your Outlook email account.

You can easily set up autoforwarding by applying a mailbox rule that forwards all mail from your Inbox to an

email account you specify. Note that if you are using an Exchange Server for your email account, you

should talk to the person responsible for maintaining the server to ensure that you can automatically forward

email to an outside address. They may need to tweak settings on the Exchange Server to allow for this, as

Exchange Server is set to not automatically reply or forward email to the Internet by default for security

purposes.

However, if you are using Outlook for POP email accounts that download to a local PST folder, you

can easily apply a mailbox rule that will allow you to forward any mail received to another email address that

you specify. If you need to review creating mail box rules, please read lesson “13.1- Creating Mailbox

Rules” in the “Advanced Outlook” manual within this product. When you create this rule on your Inbox, you

simply choose to have all mail that is received be forwarded. You then enter the email address to which you

wish to forward the email that you receive. Just as when using your other email rules, be sure to disable the

rule when you return to your office to turn off the autoforwarding.

16.10- Using Quick Parts:

Many lawyers use standard text, such as a confidentiality agreement, within their emails and then

simply make minor editing changes to the text to suit the particular situation. Whenever you have text that

you insert and use over and over again in your email, you can save it as a Quick Part in Outlook so that you

can easily insert it into future emails without having to retype it in its entirety or copy and paste it from

another email, and possibly risk exposing confidential client information in the process. Note that in order for

Quick Parts to be available in Outlook, you must also have Word installed on your computer from the same

Microsoft Office installation as well. Note, however, that Word does not have to be set as your default email

editor within Outlook to use Quick Parts

To create a Quick Part, simply type the text you wish to save as a Quick Part into the body of an

email in its unedited, meaning not personalized, state. Then select all of the text that you wish to save as a

Quick Part. Note that this content can include pictures, text, or any other content you can insert into your

email. Once you have the content selected, click the “Insert” tab within the Ribbon in the message window

and then click the “Quick Parts” button in the “Text” button group. From the drop-down menu that appears,

select the “Save Selection to Quick Part Gallery…” command to open the “Create New Building Block”

dialog box. Within this dialog box, enter a new name for the selected text into the “Name” text box, if

desired. You can enter a description of the text into the “Description” text box if you wish. Also, you can use

the “Options” drop-down to select how you want Outlook to insert the content when it is inserted into a

message in the future. Once you have made the changes to the settings that you want to keep, click the

“OK” button to save the Quick Part. Also note that you should click the “Yes” button, if prompted later on, to

permanently save your building block when exiting the Outlook program.

To insert a saved Quick Part into an email, place the insertion point at the location where you wish

to insert the information. Then click the “Quick Parts” button in the “Text” button group on the “Insert” tab

within the Ribbon. From the drop-down menu that appears, click on the name of the Quick Part that you

want to insert to place the content into your message. Then simply edit it, as needed, for your message.Sa
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Managing Mail

16.11- Using Quick Steps in Outlook:

While not available in Outlook 2007, Quick Steps were introduced in Outlook 2010 to assist users in

being more efficient with multi-step tasks that they often perform in Outlook. The default Quick Steps are

shown in the middle of the “Home” tab within the Ribbon when you have the Inbox selected. These default

Quick Steps are shown because they are used so commonly by many users. However, you can create your

own custom Quick Steps for the actions that you perform most frequently in Outlook 2010 or later.

For many Quick Steps, the first time that you click on a Quick Step you will be prompted to set up

the Quick Step by customizing the selected actions. Once you have customized the Quick Step, you will

see the icon for it appear in the Quick Steps button group on the “Home” tab within the Ribbon. You can

simply select your mail item and then click the Quick Step button to execute the Quick Step in the future.

You can also create your own Quick Steps that contain actions that you choose for the processes

that your perform most often. To create a custom Quick Step, simply click the “Create New” Quick Step

shown within the “Quick Steps” button group to open a dialog box where you can create a new Quick Step.

Start by typing a name for the Quick Step into the “Name:” text box. Then use the drop-down menu below

that to select the first action and choose any additional settings for the selected action. You can then

continue to click the “Add Action” button to add another drop-down and repeat the process until you have

added all of the actions that you need to the Quick Step. You can even assign the Quick Step a shortcut key

by selecting one from the “Shortcut Key” drop-down menu. If desired, you can enter the purpose of the

Quick Step into the “Tooltip Text:” text box. This text will appear when you hold your mouse pointer over the

Quick Step in the Ribbon, reminding you of its purpose. When you are finished, simply click the “Finish”

button to create the selected Quick Step and add it to the buttons available in the “Quick Steps” button

group.

You can also manage your Quick Steps by clicking the dialog box launcher button in the lower right

corner of the Quick Steps button group to open the “Manage Quick Steps” dialog box. You will see your

Quick Steps shown in a listing at the left side of this dialog box. You can select a Quick Step shown here

and then click either the “Edit,” “Duplicate,” or “Delete” buttons to the right to edit, copy, or delete the

selected Quick Step. If you wish to reset your Quick Steps to their default settings, you can also click the

“Reset to defaults” button in the lower left corner of this dialog box to reset the Quick Steps back to their

defaults. When you are finished managing your Quick Steps, simply click the “OK” button to close the dialog

box and return to Outlook.
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Managing Mail

16.12- Tips to Reduce PST Folder Size:

If you are not connected to an Exchange Server, then you probably use a PST folder for your Inbox

and other Outlook folders. For many lawyers, the sheer volume of mail that they handle can cause the size

of the PST file to grow very quickly. In this lesson, we will review some tips that you can use to ensure that

your PST folder size will remain manageable and that Outlook will therefore respond more quickly when you

are using it.

The first tip that you should be aware of if using a PST file is using the “Archiving” feature within

Outlook. You can create an “Archive” copy of your Inbox and its related folders that you keep in a separate

PST file. That way, you can move old mail to the archive copy for storage purposes without having to risk

deleting the information, or retaining it within your primary PST folder where it will needlessly slow down

your Inbox processing. You can archive mail within folders either manually or automatically, and you can

also set the retention policy for the email. It is also important to note that you can create and use multiple

archive folders for archiving mail (for example, by year), if needed. If you need to review the process for

AutoArchiving email, please review lesson “11.2- Setting AutoArchiving for Folders” in Chapter 11 of the

“Advanced Outlook” manual included with this product. In Outlook 2013:2010, you can also manually

archive folders by clicking the “File” tab within the Ribbon and then clicking the “Info” command at the left

side of the backstage view. Then click the “Mailbox Cleanup” drop-down button, and select the “Archive…”

command. You can then choose which folders to archive in the “Archive” dialog box that appears, as well as

set the date used to archive mail. You can also choose to which PST folder the mail will be archived by

using the “Browse…” button at the bottom of the dialog box. The default archive file folder pathway will be

shown in the adjacent “Archive file:” text box. Then click the “OK” button to start archiving mail.

If you want to open the archive file within Outlook, you can click the “File” tab within the Ribbon and

then click the “Open” command in Outlook 2010 or the “Open & Export” command in Outlook 2013 at the

left side of the backstage view. Then click the “Open Outlook Data File” command and browse to the

archive folder to open it. You can then access any mail that you have archived.

Another tip for managing your PST file size is to remember to empty your deleted items folder.

Remember that items that you delete from your Inbox and other folders are actually moved to the “Deleted

Items” folder, where they will be saved by default, until you choose to empty the folder. Items saved into the

“Deleted Items” folder will still increase the size of your PST file. So, you can easily empty your “Deleted

Items” folder by simply right-clicking on the “Deleted Items” folder within the Folder Pane, and then selecting

the “Empty Folder” command from the pop-up menu that appears.

Another tip for reducing file size is to delete unnecessary items from your “Sent Items” folder. If you

are someone who finds that they are often replying and forwarding email that you have received, it is

important to note that a copy of every email to which your replied or forwarded is kept in your “Sent Items”

folder. If you do not need to keep these items, you can open the “Sent Items” folder and then delete the sent

items that you no longer need to keep. This can also greatly reduce your PST file size, as many users forget

that they keep copies of all of these emails. Once again, after these emails are deleted from the “Sent

Items” folder the are sent to the “Deleted Items” folder, so be sure to empty your “Deleted Items” folder

when you are finished to permanently remove them from your PST file.

As long as you follow these tips, you should have a PST file that is of a manageable size and is

quick and responsive when using the Outlook application.
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ACTIONS-

Managing Mail

USING SUBFOLDERS:

1. One way to create a subfolder is to simply right-click the Inbox within the Folder Pane in Outlook, and

then select the “New Folder” command from the pop-up menu that appears.

2. A new folder will then be added to the Folder Pane beneath the Inbox.

3. In Outlook 2013, simply type a name for the new folder and then press the “Enter” key on your keyboard

to create the new subfolder.

4. In Outlook 2010:2007, the “Create New Folder” dialog box opens, where you enter the name of the

folder into the “Name:” text box and then click the “OK” button.

5. If you happen to make a mistake when naming the subfolder, you can rename a subfolder that you have

created by simply right-clicking the desired subfolder and then selecting the “Rename Folder” command

from the pop-up menu that appears.

6. You can then proceed to type the desired folder name and press the “Enter” key to set the name when

you have finished.

7. Also note that you have a great deal of control over where you place your folders and what types of

items they can contains by default. If you wish to learn more about creating folders within your Outlook

account, please review lesson “11.3- Creating Private Folders” in the Advanced Outlook manual within

the Mastering Outlook Made Easy tutorial.

8. Once you have created subfolders, you can manually move any associated mail, appointments, tasks,

or other Outlook items you receive into the designated subfolder when they arrive in your Inbox. To do

this, select the Inbox within the Folder Pane to display the email within the Inbox. Then click and drag

the email you want to move, and drop it onto the desired subfolder within the Folder Pane.

USING MAILBOX RULES TO ORGANIZE MAIL:

1. If you have subfolders created within your Inbox, you can also create mailbox rules that will move mail

to the appropriate subfolder when it is received in your Inbox if it contains specific text in the message

subject or body. This can reduce the amount of time that it takes to manually sort and organize your

Inbox and its subfolders.

2. If you need a review of the process of creating folder rules, you should review lesson “13.1- Creating

Mailbox Rules” in the “Advanced Outlook” manual within this product. Note that you can apply rules to

folders that you create, as well as your Inbox within Outlook.

3. To create rules in Outlook 2013:2010, click the “Rules” button in the “Move” group on the “Home” tab in

the Ribbon, and then select the “Manage Rules & Alerts…” command. To create rules in Outlook 2007,

select “Tools| Rules and Alerts…” from the Menu Bar.

4. In either version, the “Rules and Alerts” dialog box will then appear. Ensure that you are viewing the

“Email Rules” tab, and then click the “New Rule…” button in the upper left corner of that tab to launch

the “Rules Wizard.”

5. At this point, you simply need answer the questions posed on each screen of the wizard to create a new

rule that states that mail that arrives in your Inbox that contains words in either the body or subject that

pertain to a selected matter or case should be immediately moved to the designated folder that you

have already created.
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ACTIONS-

Managing Mail

USING SEARCH AND SEARCH FOLDERS TO ORGANIZE MAIL:

1. To create a new search folder, simply right-click on the “Search Folders” icon within the “Mail” section of

the Folder Pane and then select the “New Search Folder…” command from the pop-up menu that

appears.

2. In the “New Search Folder” dialog box that appears, you can then select the criteria by which you want

to find mail. Just as when creating mailbox rules, you can find mail by sender, mail status, or find

specific words in the subject line or body of the email.

3. If you wish to create your own criteria, you can simply select the “Create a custom Search Folder”

selection to open the “Search Folder Criteria” dialog box where you can define any and all criteria you

wish to set for your search folder.

4. Once you have created your criteria, simply click the “OK” button to create your new Search Folder.

5. To use the Search Folder, simply click on it in the Folder Pane to display all of the items within your

Inbox that match the search criteria that you specified.

6. You can then click on your Inbox folder to display all messages again.

7. Separately from creating a more permanent Search Folder, if you want to find a particular piece of mail

within your Inbox, you can simply do a quick search to find it. To do this, select the Inbox folder and then

type the word or words for which you are searching into the “Search” text box that appears above the

folder. Outlook will then filter the Inbox to display only messages that contain the text for which you are

searching.

8. You can then click the small “x” button that appears at the right end of the “Search” text box to clear the

search terms and display all of the messages in your Inbox again when you are finished.

MAKING MAIL EASIER TO SEARCH:

1. One of the quickest ways to search for email is by searching for text within the Subject line of the email.

This allows Outlook to skip scanning the body text of the actual email, thereby allowing for faster and

easier searching. To edit the subject line of an email that you have received, simply double-click on the

message within your Inbox to open the email in its own message window.

2. At that point, simply make any changes that you want to the subject line displayed within the email. This

is the point at which you would want to add the text that will categorize the email.

3. Then click the “Save” button within the Quick Access toolbar and accept any warning messages that

Outlook may show you. Note that you cannot change the subject line of an email that contains an

attachment while the attached file is opened. You must first close the attached file before editing the

subject line of the associated email.

4. Also, for Outlook 2010, which shows email sorted by conversation by default within the Inbox, you may

notice that changing the subject line doesn’t change the way that the email is grouped and displayed in

conversation view. This is because conversation view uses the “conversation” field to organize the mail-

not the “subject” field. If you wish to disable the conversation view, you can do so by clicking the “View”

tab in the Ribbon and the unchecking the “Show as Conversations” option when the Inbox is selected.

5. Alternately, you could also right-click in the message headers shown within the message list shown in

the Inbox folder, and then select the “Show as Conversations” option to uncheck it.
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ACTIONS-

Managing Mail

MANAGING REMINDERS:

1. You can use the “Flag for follow up” feature along with reminders in Outlook to aid you in remembering

the tasks and other activities that you need to complete, as well as when you must complete them. To

review setting message flags as well as reminders on Outlook emails, review lesson “3.3- Message

Flags” in the “Introductory Outlook” manual included with this product.

2. Once you have a system in place for noting reminders, however, you may find that you will have several

reminders appearing in the “Reminders” window as the items that are flagged for follow-up come due.

3. Note that while you can select each item and set a “Snooze” time individually, if you have several

reminders appearing within the window you can also select multiple reminders first and then set the

same “Snooze” time for all of the selected reminders. Selecting multiple items in the “Reminders”

window is just like making multiple selections in other windows, simply click on the first item, hold down

the “Shift” key and then click the last item to select those items and all items between them.

4. Also, for items that you have already completed, you can mark them as completed in the “Reminders”

window one at time without having to open each item individually. To do this, simply right-click on the

desired item within the “Reminders” window, and then select the “Mark Complete” option from the pop-

up window that appears. Note, however, that you can only mark one item at a time as completed. The

option to “Mark Complete” will not appear if you right-click on multiple selected reminders within the

“Reminders” window.

SAVING EMAIL AS PDF:

1. If you wish to save an email as a PDF using the PC version of Outlook, you can install a third-party

solution of your choosing. There are several free PDF creators and converters available on the Internet.

2. Once you have this software installed on your PC, you can then open your email message and select

the “Print” command.

3. In the “Print” dialog box that appears, select the “PDF Converter” option (based on the conversion

software you acquired) from the “Printer” drop-down choice when you have the email opened.

4. You can then select the desired folder to which you want to save the resultant PDF file once you click

the “OK” button to print the email.

TURNING EMAILS INTO TASKS:

1. Click and drag the desired email onto your “Tasks” folder within the Folder Pane.

2. When you release your mouse button, Outlook will convert the email into a task and display the content

within a task window where you can then set associated task information, such as a reminder date, a

due date, or task category.

3. Once you have finished creating the task, simply click the “Save & Close” button in the Ribbon or toolbar

within the “Task” window to save it.
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ACTIONS-

Managing Mail

AUTOREPLY TO EMAIL:

1. If you have an Exchange Server email account, you can enable an “Out of office” AutoReply in Outlook

2007 by selecting “Tools| Out of Office Assistant…” from the Menu Bar.

2. Enter the text that you would like to use as your out of office message.

3. You can then enable the feature by selecting the option button that says “I am currently Out of the

Office.”

4. Then click the “OK” button to finish.

5. When you return to the office, open the Out of Office Assistance again, and this time select the “I am

currently In the Office” option button to disable the feature.

6. Note that this feature changes in Outlook 2013:2010, and is available by clicking the “File” tab in the

Ribbon, and then the “Info” button in the backstage view.

7. Then select the “Automatic Replies (Out of Office)” button.

8. In the “Automatic Replies” dialog box that opens, check the “Send Automatic Replies” checkbox.

9. You can then specify a duration for the automatic replies, if needed.

10. Next, type the message that you want to have appear for users on both the “Inside my organization” and

“Outside my organization” tabs.

11. Then click the “OK” button to enable the automatic replies.

12. If you specified a duration, Outlook will stop sending auto replies when the duration expires. Otherwise,

simply return to the “Automatic Replies” dialog box and select the “Do not send automatic replies”

checkbox and then click the “OK” button.

13. If you do not have an Exchange Server account configured in your Outlook profile, you can still emulate

this feature by using an email template that you create in conjunction with the mailbox rules. To do this,

first create a plain text email message and type whatever you want your out of office reply to be as the

body of the email message.

14. Then select the “Save As” command within the message window.

15. You can then name the message whatever you want, but be sure to save the file as the file type of

“Outlook Template” by using the “Save as type” drop-down.

16. Then click the “Save” button to save the new email template.

17. You can then select your Inbox and create a new rule for the Inbox using the “Rules Wizard.” If you

need to review creating mail box rules, please read lesson “13.1- Creating Mailbox Rules” in the

“Advanced Outlook” manual within this product.

18. When you create the rule, ensure that the rule will be triggered when the condition is set to mail that is

received by you.

19. Then set the action to be reply using a template.

20. You can then edit the rule and select the email template that you just created as the email template to

use.

21. You can then finish the rule as you normally would, and click the “Finish” button when you are done.

22. You can then enable and disable the rule, as needed, in order to send an “Out of Office” reply to

received email by using the mailbox rules on your non-Exchange email account.
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ACTIONS-

Managing Mail

AUTOFORWARDING EMAIL:

1. You can easily set up autoforwarding by applying a mailbox rule that forwards all mail from your Inbox to

an email account that you specify.

2. Note that if you are using an Exchange Server for your email account, you should talk to the person

responsible for maintaining the server to ensure that you can automatically forward email to an outside

address. They may need to tweak settings on the Exchange Server to allow for this, as Exchange

Server is set to not automatically reply or forward email to the Internet by default for security purposes.

3. However, if you are using Outlook for POP email accounts that download to a local PST folder, you can

easily apply a mailbox rule that will allow you to forward any mail received to another email address that

you specify.

4. If you need to review creating mail box rules, please read lesson “13.1- Creating Mailbox Rules” in the

“Advanced Outlook” manual within this product.

5. When you create this rule on your Inbox, you simply choose to have all mail that is received be

forwarded.

6. You then enter the email address to which you wish to forward the email that you receive.

7. Just as when using your other email rules, be sure to disable the rule when you return to your office to

turn off the autoforwarding.

USING QUICK PARTS:

1. Note that in order for Quick Parts to be available in Outlook, you must also have Word installed on your

computer from the same Microsoft Office installation, as well. Note, however, that Word does not have

to be set as your default email editor within Outlook to use Quick Parts

2. To create a Quick Part, simply type the text that you wish to save as a Quick Part into the body of an

email in its unedited, meaning not personalized, state.

3. Then simply select all of the text that you wish to save as the Quick Part. Note that this content can

include pictures, text, or any other content that you can insert into your email.

4. Once you have the content selected, simply click the “Insert” tab within the Ribbon in the message

window and then click the “Quick Parts” button in the “Text” button group.

5. From the drop-down menu that appears, select the “Save Selection to Quick Part Gallery…” command

in order to open the “Create New Building Block” dialog box.

6. Within this dialog box, enter a new name for the selected text into the “Name” text box, if desired.

7. You can enter a description of the text into the “Description” text box if you wish.

8. Also, you can use the “Options” drop-down to select how you want Outlook to insert the content when it

is inserted into a message in the future.

9. Once you have made the changes to the settings that you want to keep, simply click the “OK” button to

save the Quick Part.

10. Also note that you should click the “Yes” button, if prompted, to permanently save your building block

when exiting the Outlook program.

11. To insert a saved Quick Part into an email, simply place the insertion point at the location where you

wish to insert the information.

12. Then click the “Quick Parts” button in the “Text” button group on the “Insert” tab within the Ribbon.

13. From the drop-down menu that appears, click on the name of the Quick Part that you want to insert to

place the content into your message.

14. Then simply edit it as needed for your message.Sa
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ACTIONS-

Managing Mail

USING QUICK STEPS IN OUTLOOK:

1. While not available in Outlook 2007, Quick Steps were introduced in Outlook 2010 to assist users in

being more efficient with multi-step tasks that they often perform in Outlook. The default Quick Steps are

shown in the middle of the “Home” tab within the Ribbon when you have the Inbox selected.

2. For many Quick Steps, the first time that you click on a Quick Step you will be prompted to set up the

Quick Step by customizing the selected actions.

3. Once you have customized the Quick Step, you will see the icon for it appear in the Quick Steps button

group on the “Home” tab within the Ribbon.

4. You can simply select your mail item and then click the Quick Step button to execute the Quick Step in

the future.

5. To create a custom Quick Step, simply click the “Create New” Quick Step shown within the “Quick

Steps” button group to open a dialog box where you can create a new Quick Step.

6. Start by typing a name for the Quick Step into the “Name:” text box.

7. Then use the drop-down menu below that to select the first action and choose any additional settings for

the selected action.

8. You can then continue to click the “Add Action” button to add another drop-down and repeat the process

until you have added all of the actions that you need to the Quick Step.

9. You can even assign the Quick Step a shortcut key by selecting one from the “Shortcut Key” drop-down

menu.

10. If desired, you can enter the purpose of the Quick Step into the “Tooltip Text:” text box.

11. When you are finished, simply click the “Finish” button to create the selected Quick Step and add it to

the buttons available in the “Quick Steps” button group.

12. You can also manage your Quick Steps by clicking the dialog box launcher button in the lower right

corner of the Quick Steps button group to open the “Manage Quick Steps” dialog box.

13. You will see your Quick Steps shown in a listing at the left side of this dialog box. You can select a

Quick Step shown here and then click either the “Edit,” “Duplicate,” or “Delete” buttons to the right to

edit, copy, or delete the selected Quick Step.

14. If you wish to reset your Quick Steps to their default settings, you can also click the “Reset to defaults”

button in the lower left corner of this dialog box to reset the Quick Steps back to their defaults.

15. When you are finished managing your Quick Steps, simply click the “OK” button to close the dialog box

and return to Outlook.
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Managing Mail

TIPS TO REDUCE PST FOLDER SIZE:

1. If you are not connected to an Exchange Server, then you probably use a PST folder for your Inbox and

other Outlook folders. In this lesson, we will review some tips that you can use to ensure that your PST

folder size will remain manageable.

2. The first tip that you should be aware of if using a PST file is using the “Archiving” feature within

Outlook. You can create an “Archive” copy of your Inbox and its related folders that you keep in a

separate PST file.

3. You can archive mail within folders either manually or automatically, and you can also set the retention

policy for the email. It is also important to note that you can create and use multiple archive folders for

archiving mail (for example, by year), if needed.

4. If you need to review the process for AutoArchiving email, please review lesson “11.2- Setting

AutoArchiving for Folders” in Chapter 11 of the “Advanced Outlook” manual included with this product.

5. In Outlook 2013:2010, you can also manually archive folders by clicking the “File” tab within the Ribbon

and then clicking the “Info” command at the left side of the backstage view.

6. Then click the “Mailbox Cleanup” drop-down button, and select the “Archive…” command.

7. You can then choose which folders to archive in the “Archive” dialog box that appears, as well as set the

date used to archive mail.

8. You can also choose to which PST folder the mail will be archived by using the “Browse…” button at the

bottom of the dialog box. The default archive file folder pathway will be shown in the adjacent “Archive

file:” text box.

9. Then click the “OK” button to start archiving mail.

10. If you want to open the archive file within Outlook, you can click the “File” tab within the Ribbon and then

click the “Open” command in Outlook 2010 or the “Open & Export” command in Outlook 2013 at the left

side of the backstage view.

11. Then click the “Open Outlook Data File” command and browse to the archive folder to open it. You can

then access any mail that you have archived.

12. Another tip for managing your PST file size is to remember to empty your deleted items folder.

13. You can easily empty your “Deleted Items” folder by simply right-clicking on the “Deleted Items” folder

within the Folder Pane, and then selecting the “Empty Folder” command from the pop-up menu that

appears.

14. Another tip for reducing file size is to delete unnecessary items from your “Sent Items” folder. If you are

someone who finds that they are often replying and forwarding email that you have received, it is

important to note that a copy of every email to which your replied or forwarded is kept in your “Sent

Items” folder.

15. If you do not need to keep these items, you can open the “Sent Items” folder and then delete the sent

items that you no longer need to keep.

16. Once again, after these emails are deleted from the “Sent Items” folder the are sent to the “Deleted

Items” folder, so be sure to empty your “Deleted Items” folder when you are finished to permanently

remove them from your PST file.
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EXERCISES-

Managing Mail

Purpose:

1. To be able to more effectively manage your mail within your Outlook Inbox by using several

techniques that have been discussed within this chapter.

Exercises:

1. Open your Outlook application.

2. Right-click on your Inbox and then select the “New Folder” command from the pop-up menu that

appears.

3. If the “Create New Folder” dialog box appears, type “Test Folder” into the “Name:” text box and then

click the “OK” button. Otherwise, type “Test Folder” into the highlighted name of the new folder in the

Folder Pane and then press the “Enter” key on your keyboard to set the name of the new folder.

4. Next, you will create a mailbox rule that will move email into your new “Test Folder.”

5. To access the “Rules Wizard” in Outlook 2013:2010, click the “Rules” button in the “Move” group on

the “Home” tab in the Ribbon, and then select the “Manage Rules & Alerts…” command. To access

this wizard in Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar. In either version,

the “Rules and Alerts” dialog box will then appear.

6. Ensure that you are viewing the “Email Rules” tab, and then click the “New Rule…” button in the

upper left corner of that tab to launch the “Rules Wizard.”

7. Select the “Move messages with specific words in the subject to a folder” template within the dialog

box and then click the “specific words” hyperlink in the text box at the bottom of the dialog box.

8. Type “outlook test” into the “Specify word or phrases to search for in the subject” text box, and then

click the “Add” button. When you have done that, click the “OK” button.

9. Click the “Specified” hyperlink at the bottom of the “Rules Wizard” dialog box.

10. Select the “Test Folder” subfolder within your Inbox shown in the “Rules and Alerts” dialog box, and

then click the “OK” button.

11. Click the “Finish” button at the bottom of the “Rules Wizard” dialog box.

12. Open an new email message and address it to your own email address. Enter “outlook test

message” as the “Subject” line and then type a message to yourself. When you are ready, click the

“Send” button to send the message. Click the “Send/Receive” button to perform a send and receive,

if needed. Note that the new email arrives in the “Test Folder” subfolder.

13. To delete the new rule, open the “Rules and Alerts” dialog box again. In Outlook 2013:2010, click

the “Rules” button in the “Move” group on the “Home” tab in the Ribbon, and then select the

“Manage Rules & Alerts…” command. In Outlook 2007, select “Tools| Rules and Alerts…” from the

Menu Bar. In either version, the “Rules and Alerts” dialog box will then appear.

14. Click the “E-mail Rules” tab, if needed, and then select the “outlook test” rule shown.

15. Click the “Delete” button at the top of the tab to delete the rule. Click “Yes” at the message box.

16. Click the “OK” button to close the “Rules and Alerts” dialog box.

17. Right-click on the “Test Folder” within the Folder Pane and then choose the “Delete Test Folder…”

command from the pop-up menu that appears.

18. Click “Yes” at the message box prompt to move the folder to the “Deleted Items” folder.

19. Right-click the “Deleted Items” folder within the Folder Pane and then select “Empty “Deleted Items”

Folder…” from the pop-up menu that appears.

20. Click “Yes” at the message box to permanently delete the contents of the Deleted Items folder.

21. Next, create a new mail message within Outlook in order to create a new Quick Part item.Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



21©TeachUcomp, Inc. Mastering Outlook Made Easy for Lawyers

EXERCISES-

Managing Mail

Exercises (cont.):

22. Note that in order for you to be able to use Quick Parts in Outlook, you must also have Microsoft

Word installed on the same computer from the same Microsoft Office installation. You must also be

using Outlook 2007 or later.

23. In the new mail message window, enter the following text: “This email message, including any

attachments, is intended only for the use of the individual or entity to which it is addressed and may

contain information that is privileged or confidential.”

24. Select all of the text that you just entered within the body of the message window.

25. Click the “Insert” tab in the Ribbon at the top of the message window.

26. Click the “Quick Parts” button that appears within the “Text” button group on that tab, and then select

the “Save Selection to Quick Part Gallery…” command from the drop-down menu that appears.

27. Type “Sample Privacy Statement” into the “Name:” text box within the “Create New Building Block”

dialog box that appears.

28. Use the “Options” drop-down within the dialog box to select “Insert content in its own paragraph.”

29. Click the “OK” button in the dialog box to save the Quick Part.

30. Close the email message window, click “No” to saving changes, and then open a new email

message window.

31. Click into the body of the mail message window, and then click the “Quick Parts” button in the “Text”

button group on the “Insert” tab within the Ribbon of the message window.

32. Select the “Sample Privacy Statement” text shown in the drop-down menu that appears to insert the

text as its own paragraph within the message window.

33. Click the “Quick Parts” button in the “Text” button group on the “Insert” tab within the Ribbon of the

message window, and then right-click on the “Sample Privacy Statement” text shown in the drop-

down menu. From the pop-up menu that appears, select the “Organize and Delete…” command.

34. In the “Building Blocks Organizer” window, select the “Sample Privacy Statement” entry at the left

side of the window, and then click the “Delete” button at the bottom of the listing shown.

35. Click the “yes” button in the confirmation message box to delete the Quick Part. Then click the

“Close” button within the “Building Blocks Organizer” to close the window.

36. Close the message window and click the “No” button to not save a copy of the draft.

37. Close the Outlook application.
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CHAPTER 17-

Legal Contacts

17.1- Using Bcc for Confidentiality with Contact Groups
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Legal Contacts

17.1- Using Bcc for Confidentiality with Contact Groups:

Next we will look at creating contact groups and using the Bcc feature to ensure contact

confidentiality when sending emails using contact groups. Note that contact groups were called “distribution

lists” in Outlook 2007, however they retain the same functionality in both versions. If you would like to

review the process of creating a contact group, please read lesson “2.6- Creating Contact Groups” in the

“Introductory Outlook” manual within this product.

Once you have created a contact group, you can send the group an email message by simply

addressing the email to the selected group name. However, you should NOT use the “To” or “CC” fields

when sending the message, as the individual email addresses of the contacts within the group will then be

exposed within the header of the email to all members who receive a copy! Therefore, for confidentiality

purposes, it is better to add the contact group to the “Bcc” field when sending the email so that each

member of the contact group will receive a copy of the message, but will not be able to see the email

addresses of the other members.

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



24©TeachUcomp, Inc. Mastering Outlook Made Easy for Lawyers

ACTIONS-

Legal Contacts

USING BCC FOR CONFIDENTIALITY WITH CONTACT GROUPS:

1. If you would like to review the process of creating a contact group, please read lesson “2.6- Creating

Contact Groups” in the “Introductory Outlook” manual within this product.

2. Once you have created a contact group, you can send the group an email message by simply

addressing the email to the selected group name. However, you should NOT use the “To” or “CC” fields

when sending the message, as the individual email addresses of the contacts within the group will then

be exposed within the header of the email to all members who receive a copy!

3. Therefore, for confidentiality purposes, it is better to add the contact group to the “Bcc” field when

sending the email so that each member of the contact group will receive a copy of the message, but will

not be able to see the email addresses of the other members.
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EXERCISES-

Legal Contacts

Purpose:

1. There are no exercises for this chapter.

Exercises:

1. None.
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CHAPTER 18-

Managing Legal Scheduling

18.1- Automatically Processing Meeting Requests

18.2- Using Scripts and Rules to Process Meeting Requests
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Managing Legal Scheduling

18.1- Automatically Processing Meeting Requests:

In this chapter we will discuss some additional tips and tricks that you can use when scheduling

meetings and appointments in a law firm. As many paralegals can attest to, scheduling meetings and

appointments can be quite a tricky business. There are many blocks of time when the attendees are out of

the office, or already booked for other meetings. Coordinating the calendars of many lawyers at once can be

a stressful task in itself, not to mention having to reserve resources such as conference rooms and the like.

However, if you are well versed in using Outlook for calendar scheduling, you can minimize the stress

related to managing legal scheduling.

If you need to review the basics on using the scheduling features of Outlook, you should review

“Chapter 6- Using the Calendar” in the “Introductory Outlook” manual included with this product. This will

give you the skills required to manage a complex legal schedule using Outlook’s calendar feature.

In this lesson, we will learn how to set up Outlook to automatically process meeting requests. If you

happen to run a legal schedule on a “first come, first served” basis, then this trick can save you some time in

having to respond to meeting requests that are sent out that conflict with another meeting that has already

been scheduled. Most often this occurs when the meeting organizer hasn’t checked the availability of the

other attendees or resources required. You can set Outlook to automatically process meeting requests for

resources, for example, so that they can be reserved on a “first come, first serve” basis. In this case, all

meeting requests will be accepted, unless it conflicts with another meeting scheduled. You can also choose

to deny recurring meetings, if desired.

To do this, open Outlook. If you are using Outlook 2013:2010, click the “File” tab within the Ribbon

and then select the “Options” button to open the “Outlook Options” dialog box. Here you can select the

“Mail” category at the left side of the dialog box. Then check the “Automatically process meeting requests

and responses to meeting requests and polls” checkbox. If using Outlook 2007, select “Tools| Options…”

from the Menu Bar and then click “Calendar Options.” Then under “Advanced Options” click “Resource

Scheduling.” Then check the “Automatically accept meeting requests and process cancellations” checkbox.

You can then optionally check either, neither, or both checkboxes for “Automatically decline conflicting

meeting requests” and “Automatically decline recurring meeting requests.” Then, in all versions, click the

“OK” button to accept your changes.

18.2- Using Scripts and Rules to Process Meeting Requests:

In this lesson we will look at writing a custom VBA script to accept or decline meetings and create a

rule for our mailboxes that will run the script when a specified condition has been met. This is probably as

tricky as meeting requests can get for the ordinary user. However, the benefit of using this technique is

priceless. For example, let’s say that you want to accept meeting requests ONLY IF they are sent from a

specific contact or group of contacts in a contact group, otherwise you want to decline all meeting requests.

You can create a script to accept meeting requests in VBA for Outlook, and then create a rule that will run

the script to accept the meeting request ONLY IF it comes from the contact or contacts that you specify!

To start, you will need to write a script in VBA that will allow you to accept incoming meeting

requests. On the next page is a sample script that you can enter into the VBA editor for Outlook which will

do just that. We will also discuss which parts you can alter and edit with other coding to change the function

of the script to reject all meeting requests, and also delete the meeting request after processing the request,

if desired. To start you will need to open Outlook. Next, you will need to open the VBA editor for Outlook.

You can do this by pressing “Alt” + F11 on your keyboard to open the VBA Editor for Outlook.Sa
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Managing Legal Scheduling

18.2- Using Scripts and Rules to Process Meeting Requests (cont.):

Within the “VBA Editor” window, click the small plus sign (+) next to the “Microsoft Office Outlook

Objects” to display the “ThisOutlookSession.” Then double-click on the “ThisOutlookSession” to display a

coding page to the right of the editor window. This is where you will type the following code to accept

meeting requests (everything including and between “Sub” and “End Sub”):

Sub AutoAcceptMeetings(oRequest As MeetingItem)

If oRequest.MessageClass <> "IPM.Schedule.Meeting.Request" Then

Exit Sub

End If

Dim oAppt As AppointmentItem

Set oAppt = oRequest.GetAssociatedAppointment(True)

Dim oResponse

Set oResponse = oAppt.Respond(olMeetingAccepted, True)

oResponse.Display

End Sub

If you want to change the code to decline meeting requests, you will need to change the olMeetingAccepted

term to olMeetingDeclined. The resultant line of code should look like this:

Set oResponse = oAppt.Respond(olMeetingDeclined, True)

If you want to alter the script so that it does NOT send a response to the meeting organizer, you will need to

change the oResponse.Display term to oResponse.Close (olSave). The resultant line of code would be:

oResponse.Close (olSave)

If you want to add a line of code to the script that deletes the meeting request after it has been processed,

then simply add the following line of code to the script on a new line immediately before the End Sub line:

oRequest.Delete

End Sub

Once you have created this script with the options that you prefer, then click the “Save” button within

the VBA editor window and close the window. Next, you will need to create a mailbox rule on your Inbox that

will run the script when a meeting request is received. In this case, you will probably need to create a

custom rule that is run when an item is received. You can then specify that the rule is only to be run when

the item is received from a selected contact or contact group. Then select the “Run a script” action of the

item and click the “script” hyperlink to select the “AutoAcceptMeetings” script. Then finish the rule as your

normally would. If you need to review creating mail box rules, please read lesson “13.1- Creating Mailbox

Rules” in the “Advanced Outlook” manual within this product.

Finally, you will need to change your macro security level within Outlook to allow for the script to run.

You can change the macro security level within the “Options” dialog box under the “Trust Center” in OutlookSa
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Managing Legal Scheduling

18.2- Using Scripts and Rules to Process Meeting Requests- (cont’d.):

2013:2010, or the “Security” menu in Outlook 2007. You can access the “Trust Center” in Outlook

2013:2010 by selecting the “File” tab in the Ribbon and then clicking the “Options” button at the left side of

the backstage view. Then click the “Trust Center” button at the left side of the “Options” window. Then click

the “Trust Center Settings…” button. In Outlook 2007, you can select “Tools| Macro| Security…” from the

Menu Bar. Next, in all versions, select the “Macro Settings” or “Macro Security” buttons at the left side of the

“Trust Center” to set the desired level of macro security.

You can set the security to “Notifications for all macros” to be notified by Outlook to enable macros

when you initially open your Outlook account. Using the “Enable all macros” option is often a poor choice as

security software will often reset the setting to “Notifications for digitally signed macros, all other macros

disabled.”

Your other option is to use SelfCert to sign the macro and then sign the macro after each editing

session, while leaving the macro security setting at “Notifications for digitally signed macros, all other

macros disabled” within Outlook. If you do this, be sure to re-sign the macro any time you change the code,

as it will need to be re-signed after each edit. If you are interested in using SelfCert (an optional Office

application that allows you to create self-signed macros), you can learn more about the process of adding

the program to your Office installation, if it is not already installed, at the following hyperlink:

http://support.microsoft.com/kb/217221.
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ACTIONS-

Managing Legal Scheduling

AUTOMATICALLY PROCESSING MEETING REQUESTS:

1. If you need to review the basics on using the scheduling features of Outlook, you should review 

“Chapter 6- Using the Calendar” in the “Introductory Outlook” manual included with this product. This 

will give you the skills required to manage a complex legal schedule using Outlook’s calendar feature.

2. To have Outlook automatically process meeting requests, open Outlook. 

3. If you are using Outlook 2013:2010, click the “File” tab within the Ribbon and then select the “Options”

button to open the “Outlook Options” dialog box.

4. Here you can select the “Mail” category at the left side of the dialog box.

5. Then check the “Automatically process meeting requests and responses to meeting requests and polls”

checkbox.

6. If using Outlook 2007, select “Tools| Options…” from the Menu Bar and then click “Calendar Options.”

7. Then under “Advanced Options” click “Resource Scheduling.”

8. Then check the “Automatically accept meeting requests and process cancellations” checkbox.

9. You can then optionally check either, neither or both checkboxes for “Automatically decline conflicting 

meeting requests” and “Automatically decline recurring meeting requests.”

10. Then, in all versions, click the “OK” button to accept your changes.

USING SCRIPTS AND RULES TO PROCESS MEETING REQUESTS:

1. To start you will need to open Outlook.

2. Next, you will need to open the VBA editor for Outlook. You can do this by pressing “Alt” + F11 on your 

keyboard to open the VBA Editor for Outlook.

3. Within the “VBA Editor” window, click the small plus sign (+) next to the “Microsoft Office Outlook 

Objects” to display the “ThisOutlookSession.”

4. Then double-click on the “ThisOutlookSession” to display a coding page to the right of the editor 

window.

5. This is where you will type (or copy and paste) the following code to accept meeting requests 

(everything including and between “Sub” and “End Sub”):

Sub AutoAcceptMeetings(oRequest As MeetingItem)

If oRequest.MessageClass <> "IPM.Schedule.Meeting.Request" Then

Exit Sub

End If

Dim oAppt As AppointmentItem

Set oAppt = oRequest.GetAssociatedAppointment(True)

Dim oResponse

Set oResponse = oAppt.Respond(olMeetingAccepted, True)

oResponse.Display

End Sub

(cont’d.)Sa
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ACTIONS-

Managing Legal Scheduling

USING SCRIPTS AND RULES TO PROCESS MEETING REQUESTS (CONT.):

6. If you want to change the code to decline meeting requests, you will need to change the 

olMeetingAccepted term to olMeetingDeclined. The resultant line of code should look like this:

Set oResponse = oAppt.Respond(olMeetingDeclined, True)

7. If you want to alter the script so that it does NOT send a response to the meeting organizer, you will 

need to change the oResponse.Display term to oResponse.Close (olSave). The resultant line of code 

would be:

oResponse.Close (olSave)

8. If you want to add a line of code to the script that deletes the meeting request after it has been 

processed, then simply add the following line of code to the script on a new line immediately before the 

End Sub line:

oRequest.Delete

End Sub

9. Once you have created this script with the options that you prefer, then click the “Save” button within the 

VBA editor window and close the window.

10. Next, you will need to create a mailbox rule on your Inbox that will run the script when a meeting request 

is received.

11. You can then specify that the rule is only to be run when the item is received from a selected contact or 

contact group.

12. Then select the “Run a script” action of the item and click the “script” hyperlink to select the 

“AutoAcceptMeetings” script.

13. Then finish the rule as your normally would. If you need to review creating mail box rules, please read 

lesson “13.1- Creating Mailbox Rules” in the “Advanced Outlook” manual within this product.

14. Finally, you will need to change your macro security level within Outlook to allow for the script to run. 

You can change the macro security level within the “Options” dialog box under the  “Trust Center” in 

Outlook 2013:2010, or the “Security” menu in Outlook 2007.

15. You can access the “Trust Center” in Outlook 2013:2010 by selecting the “File” tab in the Ribbon and 

then clicking the “Options” button at the left side of the backstage view. Then click the “Trust Center”

button at the left side of the “Options” window. Then click the “Trust Center Settings…” button. In 

Outlook 2007, you can select “Tools| Macro| Security…” from the Menu Bar.

16. Next, in all versions, select the “Macro Settings” or “Macro Security” buttons at the left side of the “Trust 

Center” to set the desired level of macro security.

17. You can set the security to “Notifications for all macros” to be notified by Outlook to enable macros 

when you initially open your Outlook account.

18. Another option is to use SelfCert to sign the macro and then sign the macro after each editing session, 

while leaving the macro security setting at “Notifications for digitally signed macros, all other macros 

disabled” within Outlook. If you are interested in using SelfCert (an optional Office application that 

allows you to create self-signed macros), you can learn more about the process of adding the program 

to your Office installation, if it is not already installed, at the following hyperlink: 

http://support.microsoft.com/kb/217221.Sa
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EXERCISES-

Managing Legal Scheduling

Purpose:

1. To learn how to enable and disable automatic acceptance of meeting requests.

Exercises:

1. To enable automatic acceptance of meeting requests in Outlook 2013:2010, click the “File” tab

within the Ribbon and then select the “Options” button to open the “Outlook Options” dialog box.

2. Here you can select the “Mail” category at the left side of the dialog box.

3. Then check the “Automatically process meeting requests and responses to meeting requests and

polls” checkbox. Then skip to step #8.

4. To enable automatic acceptance of meeting requests in Outlook 2007, select “Tools| Options…”

from the Menu Bar and then click “Calendar Options.”

5. Then under “Advanced Options” click “Resource Scheduling.”

6. Then check the “Automatically accept meeting requests and process cancellations” checkbox.

7. You can then optionally check either, neither or both checkboxes for “Automatically decline

conflicting meeting requests” and “Automatically decline recurring meeting requests.”

8. Then, in all versions, click the “OK” button to accept your changes.

9. To disable automatic acceptance of meeting requests, simply follow the steps above once again

for your version of Outlook, uncheck the check box, and then click the “OK” button again to accept

the change.
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CHAPTER 19-

Managing Tasks

19.1- Task Tracking vs. Forwarding Email

19.2- Viewing and Managing Task Times

19.3- Categorizing Tasks and Managing Views
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Managing Tasks

19.1- Task Tracking vs. Forwarding Email:

Many times you may have the temptation to forward an email that needs follow-up to an assistant or

colleague with some simple instructions to complete. While this is commonly done, you run the risk of

forgetting to follow-up with the individual to whom you sent the email. A better idea is to quickly convert the

email into a task and then use task assignment to manage the task. This way you will be able to see the

email in your task list and also be less likely to forget to follow-up with the person to whom you assigned the

task. If you need to review converting an email into a task, please see lesson “1.7- Turning Emails into

Tasks” within this manual for instructions. Also, if you assign the task to an individual within your

organization and your organization is using Exchange Server, you will be able to receive status reports on

the task, as well as be informed when the task has been marked as “completed” by the recipient. If you

would like to review the process of task assignment in an Exchange Server environment, please review

“Chapter 7- Tasks” within the “Introductory Outlook” manual included with this product.

19.2- Viewing and Managing Task Times:

As you create tasks within Outlook, you will often see the “Due Date” of the task displayed by

default. In this lesson, we will look at adding a few columns of information to this view to more easily

manage your tasks as well as their associated reminders. If you find that you constantly have a barrage of

reminders appearing within your Outlook application, showing the “Reminder Time” column within the

“Tasks” view will allow you to easily view and change the time at which you will be reminded to complete the

associated tasks, so that you won’t need to open and edit each item individually.

To add a “Reminder Time” column to your task view, simply right-click anywhere in the column

headings and then choose the “Field Chooser” command from the pop-up menu that appears. Outlook will

then display the “Field Chooser” dialog box which displays a listing of all of the available columns that you

can add to your current view. Simply click and drag the “Reminder Time” column out of the “Field Chooser”

dialog box and then drop it into your current view to add that column. Of course, you can also add any other

fields that you feel would help you to better organize your tasks while the “Field Chooser” is displayed.

When you have finished adding columns to the view, you can close the “Field Chooser” dialog box. Now, if

you want to edit the reminder time of a task shown within the list you can simply make the editing changes

within the column displayed in the view without having to edit the item individually or wait until the

“Reminders” window appears within Outlook.
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Managing Tasks

19.3- Categorizing Tasks and Managing Views:

Once you have started assigning tasks, you can use the power of the categories feature within

Outlook to create custom categories based on cases and then create custom task views to organize tasks

based on case. This can be a great way to organize your case and matter workload within Outlook.

First, you will need to create custom categories within Outlook for your cases and matters to which

you want to assign tasks. Also note that tasks, as well as any other Outlook item, can always be assigned to

more than one category at a time. So you can add case categories to any existing categorization scheme

that you are using and simply categorize your tasks into which ever categories are applicable. You can learn

how to create new categories in the lesson “2.7- Categorizing Contacts” within the “Introductory Outlook”

manual included with this product. This time, however, you will be creating categories for your cases and

then assigning your tasks to the categories that you create.

Once you have created the case and matter categories that you wish to use, you simply need to

categorize your tasks into the various case categories that you have created. Once that has been

accomplished, you can then customize the view of your task folder to display the tasks grouped by category

in order to organize your workload by case/matter.

To create a custom view of your task folder organized by category if using Outlook 2013:2010, click

the “View” tab in the Ribbon and then click the “Change View” button in the “Current View” group. From the

drop-down menu that appears, select the “Manage Views…” command. In Outlook 2007, select “View|

Current View| Define Views…” from the Menu Bar.

In Outlook 2013:2010, the “Manage All Views” dialog box will appear. In Outlook 2007, it is called the

“Custom View Organizer.” Click the “New…” button to the right. Type a name for the new view into the

“Create a new view:” dialog box. Name it something like “Tasks by Case” to assist you in applying the view

in the future. Next, select “Table” from the “Type of view” list. Below that, select who will have this view

available to them: “This folder, visible to everyone,” “This folder, visible only to me,” or “All Task folders.”

Then click “OK” to launch another dialog box where you can further customize the view. In Outlook

2013:2010, this dialog box is called the “Advanced View Settings” dialog box. In Outlook 2007, it is called

the “Customize View” dialog box. However, the options that you have for customizing the view are the same

for both versions.

Clicking the “Columns…” button (“Fields…” button in Outlook 2007) launches the “Show Columns”

dialog box (“Show Fields” dialog box in Outlook 2007). Here you can use the drop-down in the upper left

corner to choose which set of fields you wish to see appear in the left list. To move an available field into

your new view, select it in the left list and then click the “Add” button in the middle of this dialog box to add it

to the list at the right. You can then select the field from the list at the right and reorganize its position by

selecting it, and clicking the “Move Up” and “Move Down” buttons until it is in the place your desire. Click

“OK” when you are done adding and organizing the fields in your view.

Clicking the “Group By…” button launches the “Group By” dialog box. Here you can use the drop-

down under “Group items by” to select a field by which you can group items in your view. You can select up

to four fields by which to group. You can also set whether they will be grouped in “Ascending” (A-Z, 1-9)

order or “Descending” (Z-A, 9-1) order by selecting the desired sorting option at the right end of each

grouped field. Select “Categories” from the “Group items by” drop-down and then select the desired sort

order for the groups. When you are done here, click “OK” to set the grouping for your view.

Clicking the “Sort…” button launches the “Sort” dialog box. Here you can use the drop-down

available under the “Sort items by” and “Then by” sections to indicate by which field(s) you want to sort the

view. You can sort by up to four fields, and they can be sorted in either “Ascending” order or “Descending”

order by selecting the appropriate option at the right end of each field. You should select fields for sorting

that will assist you in seeing the tasks that are most urgent to complete at the top of each case category.Sa
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Managing Tasks

19.3- Categorizing Tasks and Managing Views (cont.):

Popular choices include “Start Date,” “Due Date,” and “Priority.” Remember to select the desired sorting

method for any fields by which you choose to sort your tasks. When you are done here, you can click “OK”

to set the sorting for your view.

At this point, you should have a fairly good view that allows you to view tasks grouped by category

(case) and sorted by your desired field priorities. When you are satisfied with all of the view’s settings, click

“OK” in the “Advanced View Settings” dialog box (“Customize View” dialog box in 2007) to return to the

“Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007).

You will now see the name of your view shown in the list of views available in the dialog box. To

apply your view, just click on its name to select it from the list, and click the “Apply View” button at the

bottom of the dialog box. Another way to apply the view is to select the name of your custom view that

appears in the “Current View” group on the “Home” tab of the Ribbon in Outlook 2013:2010. It will also

appear in the side menu that is shown when you select “View| Current View” from the Menu Bar in Outlook

2007.

Note that if you want to modify the view that you have created, you can select the name of the view

from the listing shown in the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007),

and then click the “Modify…” button at the right side of the dialog box. You can then make the modifications

that you desire, and then save the changes to the view. Also note that in this same area, you can select the

name of a custom view that you have created and then click the “Delete” button to delete the custom view if

you will no longer need to use it.

When you have finished using the dialog box, click the “Close” button at the bottom of the dialog box

to close it.
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ACTIONS-

Managing Tasks

TASK TRACKING VS. FORWARDING EMAIL:

1. Instead of forwarding an email that you have received that needs follow-up to an assistant or colleague, 

a better idea is to to quickly convert the email into a task and then use task assignment to manage the 

task. If you need to review converting an email into a task, please see lesson “1.7- Turning Emails into 

Tasks” within this manual for instructions.

2. If you assign the task to an individual within your organization and your organization is using Exchange 

Server, you will be able to receive status reports on the task as well as be informed when the task has 

been marked as “completed” by the recipient. If you would like to review the process of task assignment 

in an Exchange Server environment, please review “Chapter 7- Tasks” within the “Introductory Outlook”

manual included with this product.

VIEWING AND MANAGING TASK TIMES:

1. As you create tasks within Outlook, you will often see the “Due Date” of the task displayed by default. If 

you find that you constantly have a barrage of reminders appearing within your Outlook application, 

showing the “Reminder Time” column within the “Tasks” view will allow you to easily view and change 

the time at which you will be reminded to complete the associated tasks, so that you won’t need to open 

and edit each item individually.

2. To add a “Reminder Time” column to your task view, simply right-click anywhere in the column headings 

and then choose the “Field Chooser” command from the pop-up menu that appears.

3. Outlook will then display the “Field Chooser” dialog box which displays a listing of all of the available 

columns that you can add to your current view.

4. Simply click and drag the “Reminder Time” column out of the “Field Chooser” dialog box and then drop it 

into your current view to add that column. Of course, you can also add any other fields that you feel 

would help you to better organize your tasks while the “Field Chooser” is displayed.

5. When you have finished adding columns to the view, you can close the “Field Chooser” dialog box.

6. Now, if you want to edit the reminder time of a task shown within the list you can simply make the 

editing changes within the column displayed in the view without having to edit the item individually or 

wait until the “Reminders” window appears within Outlook.

CATEGORIZING TASKS AND MANAGING VIEWS:

1. Once you have started assigning tasks, you can use the power of the categories feature within Outlook 

to create custom categories based on cases and then create custom task views to organize tasks based 

on case. This can be a great way to organize your case and matter workload within Outlook.

2. First, you will need to create custom categories within Outlook for your cases and matters to which you 

want to assign tasks. Also note that tasks, as well as any other Outlook item, can always be assigned to 

more than one category at a time. So you can add case categories to any existing categorization 

scheme that you are using and simply categorize your tasks into which ever categories are applicable. 

You can learn how to create new categories in the lesson “2.7- Categorizing Contacts” within the 

“Introductory Outlook” manual included with this product. This time, however, you will be creating 

categories for your cases and then assigning your tasks to the categories that you create.

(cont.)Sa
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ACTIONS-

Managing Tasks

CATEGORIZING TASKS AND MANAGING VIEWS (CONT.):

3. Once you have created the case and matter categories that you wish to use, you simply need to 

categorize your tasks into the various case categories that you have created.

4. Once that has been accomplished, you can then customize the view of your task folder to display the 

tasks grouped by category in order to organize  your workload by case/matter.

5. To create a custom view of your task folder organized by category if using Outlook 2013:2010, click the 

“View” tab in the Ribbon and then click the “Change View” button in the “Current View” group. From the 

drop-down menu that appears, select the “Manage Views…” command.

6. In Outlook 2007, select “View| Current View| Define Views…” from the Menu Bar.

7. In Outlook 2013:2010, the “Manage All Views” dialog box will appear. In Outlook 2007, it is called the 

“Custom View Organizer.”

8. Click the “New…” button to the right.

9. Type a name for the new view into the “Create a new view:” dialog box. Name it something like “Tasks 

by Case” to assist you in applying the view in the future.

10. Next, select “Table” from the “Type of view” list.

11. Below that, select who will have this view available to them: “This folder, visible to everyone,” “This 

folder, visible only to me,” or “All Task folders.”

12. Click “OK” to launch another dialog box where you can further customize the view. In Outlook 

2013:2010, this dialog box is called the “Advanced View Settings” dialog box. In Outlook 2007, it is 

called the “Customize View” dialog box. However, the options that you have for customizing the view 

are the same for both versions.

13. Clicking the “Columns…” button (“Fields…” button in Outlook 2007) launches the “Show Columns”

dialog box (“Show Fields” dialog box in Outlook 2007). Here you can use the drop-down in the upper left 

corner to choose which set of fields you wish to see appear in the left list.

14. To move an available field into your new view, select it in the left list and then click the “Add” button in 

the middle of this dialog box to add it to the list at the right.

15. You can then select the field from the list at the right and reorganize its position by selecting it, and 

clicking the “Move Up” and “Move Down” buttons until it is in the place your desire.

16. Click “OK” when you are done adding and organizing the fields in your view.

17. Clicking the “Group By…” button launches the “Group By” dialog box. Here you can use the drop-down 

under “Group items by” to select a field by which you can group items in your view. You can select up to 

four fields by which to group. You can also set whether they will be grouped in “Ascending” (A-Z, 1-9) 

order or “Descending” (Z-A, 9-1) order by selecting the desired sorting option at the right end of each 

grouped field.

18. Select “Categories” from the “Group items by” drop-down and then select the desired sort order for the 

groups.

19. When you are done here, click “OK” to set the grouping for your view.

20. Clicking the “Sort…” button launches the “Sort” dialog box.

21. Here you can use the drop-down available under the “Sort items by” and “Then by” sections to indicate 

by which field(s) you want to sort the view.

22. You can sort by up to four fields, and they can be sorted in either “Ascending” order or “Descending”

order by selecting the appropriate option at the right end of each field. You should select fields for 

sorting that will assist you in seeing the tasks that are most urgent to complete at the top of each case 

category.

(cont.)Sa
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ACTIONS-

Managing Tasks

CATEGORIZING TASKS AND MANAGING VIEWS (CONT.):

23. Popular choices include “Start Date,” “Due Date,” and “Priority.” Remember to select the desired sorting 

method for any fields by which you choose to sort your tasks.

24. When you are done here, you can click “OK” to set the sorting for your view.

25. At this point, you should have a fairly good view that allows you to view tasks grouped by category 

(case) and sorted by your desired field priorities. When you are satisfied with all of the view’s settings, 

click “OK” in the “Advanced View Settings” dialog box (“Customize View” dialog box in 2007) to return to 

the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007).

26. You will now see the name of your view shown in the list of views available in the dialog box. To apply 

your view, just click on its name to select it from the list, and click the “Apply View” button at the bottom 

of the dialog box.

27. Another way to apply the view is to select the name of your custom view that appears in the “Current 

View” group on the “Home” tab of the Ribbon in Outlook 2013:2010. It will also appear in the side menu 

that is shown when you select “View| Current View” from the Menu Bar in Outlook 2007.

28. Note that if you want to modify the view that you have created, you can select the name of the view from 

the listing shown in the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007), 

and then click the “Modify…” button at the right side of the dialog box. You can then make the 

modifications that you desire, and then save the changes to the view.

29. Also note that in this same area, you can select the name of a custom view that you have created and 

then click the “Delete” button to delete the custom view if you will no longer need to use it.

30. When you have finished using the dialog box, click the “Close” button at the bottom of the dialog box to 

close it.
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EXERCISES-

Managing Tasks

Purpose:

1. To be able to create a custom view that arranges tasks by category, start date, and due date.

Exercises:

1. If using Outlook 2013:2010, click the “View” tab in the Ribbon and click the “Change View” button in 

the “Current View” group. Then select the “Manage Views…” command from the drop-down menu.

2. In Outlook 2007, select “View| Current View| Define Views…” from the Menu Bar.

3. In Outlook 2013:2010, the “Manage All Views” dialog box will appear. In Outlook 2007, it is called 

the “Custom View Organizer.”

4. Click the “New…” button to the right.

5. Type “Tasks by Case” into the “Name” text box within the “Create a new view:” dialog box.

6. Next, select “Table” from the “Type of view” list.

7. Below that, select who will have this view available to them: “This folder, visible to everyone,” “This 

folder, visible only to me,” or “All Task folders.”

8. Click “OK” to launch another dialog box where you can further customize the view. In Outlook 2010, 

this dialog box is called the “Advanced View Settings” dialog box. In Outlook 2007, it is called the 

“Customize View” dialog box. However, the options that you have for customizing the view are the 

same for both versions.

9. Click the “Group By…” button to launch the “Group By” dialog box.

10. Select “Categories” from the “Group items by” drop-down and then select the desired sort order for 

the groups, either “Ascending” or “Descending.”

11. When you are done here, click “OK” to set the grouping for your view.

12. Click the “Sort…” button to open the “Sort” dialog box.

13. Use the drop-down available under “Sort items by” to select “Start Date.”

14. Use the drop-down under “Then by” to select “Due Date.”

15. Click “OK” to set the sorting for your view.

16. Click “OK” in the “Advanced View Settings” dialog box (“Customize View” dialog box in 2007) to 

return to the “Manage All Views” dialog box (“Custom View Organizer” dialog box in 2007).

17. You will now see the name of your view shown in the list of views available in the dialog box. To 

apply your view, just click on its name to select it from the list, and click the “Apply View” button at 

the bottom of the dialog box.

18. When you have finished using the dialog box, click the “Close” button at the bottom of the dialog box 

to close it.
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CHAPTER 20-

Security

20.1- Using a Digital ID

20.2- Sending Encrypted Email

20.3- Adding Confidentiality Agreements

20.4- Deferring Mail Delivery
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Security

20.1- Using a Digital ID:

One way to ensure that your email is more secure is to purchase a digital ID. The digital ID, also

often called a digital certificate, proves that you are who you claim to be in your email by proving your

identity to the recipient and aids in reducing email tampering. It does this by adding a unique code to your

mail message which can only come from the digital ID of the sender.

The first step in using a digital ID is to acquire a digital ID. The process is slightly different for an

Exchange email account versus a POP email account with a PST folder. If you are not connected to an

Exchange Server, then you can get a digital ID by selecting the “File” tab in Outlook 2013:2010 and then

clicking the “Options” button. In the “Options” dialog box, select the “Trust Center.” Under “Microsoft Outlook

Trust Center,” click “Trust Center Settings.” Then click the “E-mail Security” button. If you are using Outlook

2007, select “Tools| Trust Center…” from the Menu Bar, instead. In the “Trust Center” window, click the “E-

mail Security” button.

Then, in both versions, you can click the “Get a Digital ID…” button in the “Digital IDs (Certificates)”

section shown. At that point your web browser should open and display a listing of digital ID providers.

Simply select the provider you want to use and click on their hyperlink to follow the instructions on

registering for a digital ID. The selected authority will then provide you further instructions via email.

Once you have installed a digital ID on your computer, you will need to select the digital ID that you

want to use. Some individuals may have more than one digital ID- for example, one is used to provide a

digital signature which can have legal significance in some locations, and another could be used for email

encryption. To select a digital ID to use, follow the instructions shown above for your version of Outlook to

access the “E-mail Security” window in the “Trust Center” again. This time, however, click the “Settings…”

button shown under the “Encrypted E-mail” section to open the “Change Security Settings” dialog box.

Note that if you use a digital ID, the settings will already be configured for you. If you want to use a

different digital ID, then click the “New…” button under the “Security Setting Preferences” section. Then

type a name into the “Security Settings Name” text box. In the “Cryptography Format” drop-down list, select

“S/MIME.” Note that depending on your certificate type, you may need to select “Exchange Security”

instead. Next to the “Signing Certificate” label, click the “Choose…” button to then select a digital ID that you

use for digital signatures. Then ensure that the “Send these certificates with signed messages” checkbox is

checked. Also note that the settings you specify here will be the default used for all cryptographic messages

sent unless you uncheck the “Default Security Setting for all cryptographic messages” checkbox.

Note that to send and receive encrypted email messages, both the sender and the recipient of the

email must share their digital ID certificates with the other. When you, or a recipient of your digitally signed

email, receive email that is digitally signed you should open the email. Note that digitally signed email is

denoted in Outlook by the signature icon in the message list shown within the Inbox. Once the email

message is opened, the recipient should right-click on the “From” line in the email message and then select

the “Add to Outlook Contacts” command from the pop-up menu that appears. If there is already an entry for

this individual in your contacts folder, then select the “Update Information of Selected Contact” command in

the “Duplicate Contact Detected” message box that appears. The old contact information is then moved to

the “Deleted Items” folder. At this point, the certificate is now stored with the contact information for this

individual, and you can send encrypted messages to this person.

Now if you are using an Exchange Server account for email, your administrator can give you a

“token” to use the Exchange Server digital ID- if one has been installed. To do this, you follow the same

instructions as above for your version of Outlook to open the “Trust Center” and then click the “Get a Digital

ID…” button. Then click “Set up Security for me on the Exchange,” and then click “OK.” In the “Digital ID

Name” text box, type your name. In the “Token” text box, enter the password your Exchange administrator

has given you. In the “Microsoft Office Outlook Security Password” text box, type a different password ofSa
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Security

20.1- Using a Digital ID (cont.):

your choosing and then re-enter the same password into the “Confirm” text box. You will then receive an

email from your Exchange administrator that will require you to re-enter the password that you just created.

In the dialog box that appears when you open the message, enter the password you created and

then check the checkbox for “Remember password for” and then enter the number of minutes that you want

Outlook to remember this password. Then, in the “Root Certificate Store” message box that appears, click

the “Yes” button. You can then send digitally signed email through your Exchange Server email account.

20.2- Sending Encrypted Email:

Once you have a digital ID, you can then send encrypted email. Note that before you can send

encrypted email, you must first send the recipients of your encrypted email a digitally signed mail message

so that they can add your digital signature to their contacts folder. This signature will then allow these

recipients to read the unencrypted version of your email. People who do not have a copy of your digital ID

will see encrypted, jumbled text instead of the content of your email. That way, only people who have a copy

of your digital ID can see the content of your email- guaranteeing mail security. Also note that this

encryption process will encrypt the content of any attachments sent with the encrypted mail message. If you

need to learn more about digital IDs, please read the previous section “5.1- Using a Digital ID” in this

chapter.

To send an encrypted email to a recipient who has a copy of your digital ID, simply create a new

email message and then click the “Encrypt Message Contents and Attachments” button located in the

“Options” tab in Outlook 2013:2010 or on the “Options” group on the “Message” tab in Outlook 2007 that is

shown within the email message window. Note that if you do not see this button, you can click the “dialog

box launcher” button in the lower right corner of the “More Options” or “Options” button group to open the

“Properties” dialog box. Here you can click the “Security Settings” button. In the “Security Settings” dialog

box, check the “Encrypt message contents and attachments” check box. Then click the “OK” button until you

return to the message window. You can then create the content of the message, add any attachments

needed, and send the message as you normally would.

If you wish to only send encrypted email by default, you can change the settings in Outlook to allow

this, however you should note that any recipients must have a copy of your digital ID in order to read your

mail messages.

To do this in Outlook 2013:2010, select the “File” tab and then click the “Options” button. In the

“Options” dialog box, select the “Trust Center.” Under “Microsoft Outlook Trust Center,” click “Trust Center

Settings….” Then click the “E-mail Security” button. If you are using Outlook 2007, select “Tools| Trust

Center…” from the Menu Bar, instead. In the “Trust Center” window, click the “E-mail Security” button.

Under the “Encrypted E-mail” section, select the “Encrypt contents and attachments for outgoing

messages” check box. Note that if you need to make changes here, such as selecting a specific digital ID to

use for encryption, you can click the “Settings…” button to make a digital ID selection. When finished, you

can then click the “OK” button to save your changes until you return to the main Outlook window.

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



44©TeachUcomp, Inc. Mastering Outlook Made Easy for Lawyers

Security

20.3- Adding Confidentiality Agreements:

Many lawyers add confidentiality agreements to their email. One way to add a confidentiality

agreement is to create the agreement as a building block which you can then insert into your email as

needed. If you wish to review creating building blocks, please read lesson “1.10- Using Quick Parts” in

Chapter 1 of this manual. Alternately, you can add the confidentiality agreement to your email as part of

your signature. You can then set all email that is sent from your account to use the selected signature,

ensuring that you will not forget to add it to any outgoing emails. Note that a signature file that is added to

outgoing email is not the same as a digital ID used to create digital signatures. These are two completely

different things in Outlook, although the terminology is similar.

To create a new signature, or edit your current signature, open a new mail message window. Then

click the “Signature” button in the “Include” button group on the “Message” tab in the Ribbon. Then select

the “Signatures…” command from the button’s drop-down menu to open the “Signatures and Stationery”

dialog box. To create a new signature file, click the “New” button on the “E-mail Signature” tab. Then enter a

name for the signature file and click the “OK” button. Next, in the “Edit Signature” dialog box that appears,

type the text that you want to include in the signature file. At the bottom of the signature, you can then add

the text of the confidentiality agreement to the signature file. You can make the confidentiality agreement

stand apart from the signature by selecting the text and then applying formatting to the confidentiality

agreement, such as bolded text or red text color, for example. Once you have created the signature file that

contains the confidentiality agreement, simply click the “OK” button to save the signature file.

You can manually insert a signature into an email by clicking the “Signature” button in the “Include”

button group on the “Message” tab in the Ribbon when creating a new mail message and then selecting the

signature to use from the button’s drop-down menu. You can also set Outlook to automatically use a

selected signature when creating new email and replying or forwarding email. To set Outlook to

automatically use your confidentiality agreement signature, click the “Signature” button in the “Include”

button group on the “Message” tab in the Ribbon within a mail message window. Then select the

“Signatures…” command from the button’s drop-down menu to open the “Signatures and Stationery” dialog

box. Under the “Choose default signature” section, in the “E-mail account” list, select an e-mail account to

associate with the signature. From the “New messages” drop-down, select the signature to use when

creating new mail messages. If you want to use the same signature for replies and forwards, from the

“Replies/forwards” drop-down, select the signature file. Then click the “OK” button when finished to set the

new default signature for your mail, so that you won’t need to worry about forgetting to add the

confidentiality agreement to your mail messages.
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Security

20.4- Deferring Mail Delivery:

You may consider setting up a rule to defer mail delivery. When you defer delivery, the email will sit

in the Outbox for a specified number of minutes before it will be sent. This allows you time to ensure that

your email contains all of the necessary information, and reduces the chances that you will send an email

message by mistake to the incorrect recipients or with the incorrect content.

If you need a review of the process of creating mailbox rules, you should review lesson “13.1-

Creating Mailbox Rules” in the “Advanced Outlook” manual within this product. If using Outlook 2013:2010,

click the “Rules” button in the “Move” group on the “Home” tab in the Ribbon and then select the “Manage

Rules & Alerts…” command. If using Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar.

In either version, the “Rules and Alerts” dialog box will then appear. Ensure that you are viewing the

“Email Rules” tab, and then click the “New Rule…” button in the upper left corner of that tab to launch the

“Rules Wizard.” Then click the “Apply rule on messages I send” choice under the “Start from a blank rule”

section. Then click the “Next >” button to continue.

The next window asks you to specify additional conditions. Don’t make any choices here, but instead

click the “Next >” button to continue. Outlook will then display a message box asking if you want this rule to

be applied to every message you send. Click the “Yes” button to confirm this.

In the next window, check the “defer delivery by a number of minutes” action. Then click the “a

number of” hyperlink at the bottom of the window to open the “Defer Delivery” dialog box where you will

enter the number of minutes to defer delivery and then click the “OK” button. Then click the “Next >” button

to continue.

In the next window, you can choose to allow certain mail through, if desired. For example, if you wish

to have all mail marked as “High” importance sent immediately, you can check the “except if it is marked as

importance” check box and then click the “importance” hyperlink at the bottom of the window to open the

“Importance” dialog box where you can select “High” and then click “OK” to set it. When you are finished,

click the “Next >” button to continue.

In the last window, type a name for your rule such as “Defer Mail Delivery” into the “Step 1: Specify a

name for this rule” text box. Then ensure that the “Turn on this rule” check box is checked under the “Step 2:

Setup rule options:” section. You can check the “Create this rule on all accounts” checkbox if you use

multiple email accounts. Then click the “Finish” button when you are done to apply the new rule.
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ACTIONS-

Security

USING A DIGITAL ID:

1. The first step in using a digital ID is to acquire a digital ID. The process is slightly different for an 

Exchange email account versus a POP email account with a PST folder. If you are not connected to an 

Exchange Server, then you can get a digital ID by selecting the “File” tab in Outlook 2013:2010 and then 

clicking the “Options” button.

2. In the “Options” dialog box, select the “Trust Center.”

3. Under “Microsoft Outlook Trust Center,” click “Trust Center Settings.”

4. Then click the “E-mail Security” button.

5. If you are using Outlook 2007, select “Tools| Trust Center…” from the Menu Bar, instead.

6. In the “Trust Center” window, click the “E-mail Security” button.

7. Then, in both versions, you can click the “Get a Digital ID…” button in the “Digital IDs (Certificates)”

section shown.

8. At that point your web browser should open and display a listing of digital ID providers. Simply select the 

provider you want to use and click on their hyperlink to follow the instructions on registering for a digital 

ID. The selected authority will then provide you further instructions via email.

9. Once you have installed a digital ID on your computer, you will need to select the digital ID that you 

want to use.

10. To select a digital ID to use, follow the instructions shown above for your version of Outlook to access 

the “E-mail Security” window in the “Trust Center” again.

11. This time, however, click the “Settings…” button shown under the “Encrypted E-mail” section to open 

the “Change Security Settings” dialog box.

12. Note that if you use a digital ID, the settings will already be configured for you. If you want to use a 

different digital ID, then click the “New…” button under the “Security Setting Preferences” section.

13. Then type a name into the “Security Settings Name” text box.

14. In the “Cryptography Format” drop-down list, select “S/MIME.”

15. Note that depending on your certificate type, you may need to select “Exchange Security” instead.

16. Next to the “Signing Certificate” label, click the “Choose…” button to then select a digital ID that you use 

for digital signatures.

17. Then ensure that the “Send these certificates with signed messages” checkbox is checked.

18. Also note that the settings you specify here will be the default used for all cryptographic messages sent 

unless you uncheck the “Default Security Setting for all cryptographic messages” checkbox.

19. Note that to send and receive encrypted email messages, both the sender and the recipient of the email 

must share their digital ID certificates with the other.

20. When you, or a recipient of your digitally signed email, receive email that is digitally signed you should 

open the email.

21. Once the email message is opened, the recipient should right-click on the “From” line in the email 

message and then select the “Add to Outlook Contacts” command from the pop-up menu that appears.

22. If there is already an entry for this individual in your contacts folder, then select the “Update Information 

of Selected Contact” command in the “Duplicate Contact Detected” message box that appears. The old 

contact information is then moved to the “Deleted Items” folder.

23. At this point, the certificate is now stored with the contact information for this individual, and you can 

send encrypted messages to this person.

(cont.)
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ACTIONS-

Security

USING A DIGITAL ID:

24. Now if you are using an Exchange Server account for email, your administrator can give you a “token” to 

use the Exchange Server digital ID- if one has been installed.

25. To do this, you follow the same instructions as above for your version of Outlook to open the “Trust 

Center” and then click the “Get a Digital ID…” button.

26. Then click “Set up Security for me on the Exchange,” and then click “OK.”

27. In the “Digital ID Name” text box, type your name.

28. In the “Token” text box, enter the password your Exchange administrator has given you.

29. In the “Microsoft Office Outlook Security Password” text box, type a different password of your choosing 

and then re-enter the same password into the “Confirm” text box.

30. You will then receive an email from your Exchange administrator that will require you to re-enter the 

password that you just created.

31. In the dialog box that appears when you open the message, enter the password you created and then 

check the checkbox for “Remember password for” and then enter the number of minutes that you want 

Outlook to remember this password.

32. Then, in the “Root Certificate Store” message box that appears, click the “Yes” button.

33. You can then send digitally signed email through your Exchange Server email account.

SENDING ENCRYPTED EMAIL:

1. Once you have a digital ID, you can then send encrypted email. If you need to learn more about digital 

IDs, please read section “5.1- Using a Digital ID” in this chapter.

2. To send an encrypted email to a recipient who has a copy of your digital ID, simply create a new email 

message and then click the “Encrypt Message Contents and Attachments” button located in the 

“Options” tab in Outlook 2013:2010 or on the “Options” group on the “Message” tab in Outlook 2007 that 

is shown within the email message window.

3. Note that if you do not see this button, you can click the “dialog box launcher” button in the lower right 

corner of the “More Options” or “Options” button group to open the “Properties” dialog box.

4. Here you can click the “Security Settings” button. In the “Security Settings” dialog box, check the 

“Encrypt message contents and attachments” check box.

5. Then click the “OK” button until you return to the message window.

6. You can then create the content of the message, add any attachments needed, and send the message 

as you normally would.

7. If you wish to only send encrypted email by default, you can change the settings in Outlook to allow this, 

however you should note that any recipients must have a copy of your digital ID in order to read your 

mail messages.

8. To do this in Outlook 2013:2010, select the “File” tab and then click the “Options” button. In the 

“Options” dialog box, select the “Trust Center….” Under “Microsoft Outlook Trust Center,” click “Trust 

Center Settings.” Then click the “E-mail Security” button.

9. If you are using Outlook 2007, select “Tools| Trust Center…” from the Menu Bar, instead. In the “Trust 

Center” window, click the “E-mail Security” button.

10. Under the “Encrypted E-mail” section, select the “Encrypt contents and attachments for outgoing 

messages” check box. Note that if you need to make changes here, such as selecting a specific digital 

ID to use for encryption, you can click the “Settings…” button to make a digital ID selection.

11. When finished, click the “OK” button to save your changes until you return to the main Outlook window.Sa
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ACTIONS-

Security

ADDING CONFIDENTIALITY AGREEMENTS BY USING A SIGNATURE:

1. To create a new signature, or edit your current signature, open a new mail message window.

2. Click the “Signature” button in the “Include” button group on the “Message” tab in the Ribbon.

3. Select the “Signatures…” command from the button’s drop-down menu to open the “Signatures and 

Stationery” dialog box.

4. To create a new signature file, click the “New” button on the “E-mail Signature” tab.

5. Then enter a name for the signature file and click the “OK” button.

6. Next, in the “Edit Signature” dialog box that appears, type the text that you want to include in the 

signature file.

7. At the bottom of the signature, you can then add the text of the confidentiality agreement to the 

signature file. You can make the confidentiality agreement stand apart from the signature by selecting 

the text and then applying formatting to the confidentiality agreement, such as bolded text or red text 

color, for example.

8. Once you have created the signature file that contains the confidentiality agreement, simply click the 

“OK” button to save the signature file.

9. You can manually insert a signature into an email by clicking the “Signature” button in the “Include”

button group on the “Message” tab in the Ribbon when creating a new mail message and then selecting 

the signature to use from the button’s drop-down menu.

10. You can also set Outlook to automatically use a selected signature when creating new email and 

replying or forwarding email. To set Outlook to automatically use your confidentiality agreement 

signature, click the “Signature” button in the “Include” button group on the “Message” tab in the Ribbon 

within a mail message window.

11. Then select the “Signatures…” command from the button’s drop-down menu to open the “Signatures 

and Stationery” dialog box.

12. Under the “Choose default signature” section, in the “E-mail account” list, select an e-mail account to 

associate with the signature.

13. From the “New messages” drop-down, select the signature to use when creating new mail messages.

14. If you want to use the same signature for replies and forwards, from the “Replies/forwards” drop-down, 

select the signature file.

15. Then click the “OK” button when finished to set the new default signature for your mail, so that you won’t 

need to worry about forgetting to add the confidentiality agreement to your mail messages.
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ACTIONS-

Security

DEFERRING EMAIL DELIVERY USING RULES:

1. If using Outlook 2013:2010, click the “Rules” button in the “Move” group on the “Home” tab in the 

Ribbon and then select the “Manage Rules & Alerts…” command.

2. If using Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar.

3. In either version, the “Rules and Alerts” dialog box will then appear. Ensure that you are viewing the 

“Email Rules” tab, and then click the “New Rule…” button in the upper left corner of that tab to launch 

the “Rules Wizard.”

4. Click the “Apply rule on messages I send” choice under the “Start from a blank rule” section.

5. Click the “Next >” button to continue.

6. The next window asks you to specify additional conditions. Don’t make any choices here, but instead 

click the “Next >” button to continue.

7. Outlook will then display a message box asking if you want this rule to be applied to every message you 

send. Click the “Yes” button to confirm this.

8. In the next window, check the “defer delivery by a number of minutes” action.

9. Click the “a number of” hyperlink at the bottom of the window to open the “Defer Delivery” dialog box 

where you will enter the number of minutes to defer delivery and then click the “OK” button.

10. Click the “Next >” button to continue.

11. In the next window, you can choose to allow certain mail through, if desired. For example, if you wish to 

have all mail marked as “High” importance sent immediately, you can check the “except if it is marked 

as importance” check box and then click the “importance” hyperlink at the bottom of the window to open 

the “Importance” dialog box where you can select “High” and then click “OK” to set it.

12. When you are finished, click the “Next >” button to continue.

13. In the last window, type a name for your rule such as “Defer Mail Delivery” into the “Step 1: Specify a 

name for this rule” text box.

14. Then ensure that the “Turn on this rule” check box is checked under the “Step 2: Setup rule options:”

section.

15. You can check the “Create this rule on all accounts” checkbox if you use multiple email accounts.

16. Then click the “Finish” button when you are done to apply the new rule.

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



50©TeachUcomp, Inc. Mastering Outlook Made Easy for Lawyers

EXERCISES-

Security

Purpose:

1. To learn how to create a rule to defer mail delivery for email sent from your email account.

Exercises:

1. If using Outlook 2013:2010, click the “Rules” button in the “Move” group on the “Home” tab in the

Ribbon and then select the “Manage Rules & Alerts…” command.

2. If using Outlook 2007, select “Tools| Rules and Alerts…” from the Menu Bar.

3. In either version, the “Rules and Alerts” dialog box will then appear. Ensure that you are viewing the

“Email Rules” tab, and then click the “New Rule…” button in the upper left corner of that tab to

launch the “Rules Wizard.”

4. Click the “Apply rule on messages I send” choice under the “Start from a blank rule” section.

5. Click the “Next >” button to continue.

6. The next window asks you to specify additional conditions. Don’t make any choices here, but

instead click the “Next >” button to continue.

7. Outlook will then display a message box asking if you want this rule to be applied to every message

you send. Click the “Yes” button to confirm this.

8. In the next window, check the “defer delivery by a number of minutes” action.

9. Click the “a number of” hyperlink at the bottom of the window to open the “Defer Delivery” dialog box

where you will enter the number of minutes to defer delivery and then click the “OK” button.

10. Click the “Next >” button to continue.

11. In the next window, you can choose to allow certain mail through, if desired. For example, if you

wish to have all mail marked as “High” importance sent immediately, you can check the “except if it

is marked as importance” check box and then click the “importance” hyperlink at the bottom of the

window to open the “Importance” dialog box where you can select “High” and then click “OK” to set

it.

12. When you are finished, click the “Next >” button to continue.

13. In the last window, type a name for your rule such as “Defer Mail Delivery” into the “Step 1: Specify a

name for this rule” text box.

14. Then ensure that the “Turn on this rule” check box is checked under the “Step 2: Setup rule options:”

section.

15. You can check the “Create this rule on all accounts” checkbox if you use multiple email accounts.

16. Then click the “Finish” button when you are done to apply the new rule.

17. If you wish to delete or disable this rule in the future, open the “Rules and Alerts” dialog box, select

the rule, and then either uncheck it to disable it or click the “Delete…” button to delete it. If you

choose to delete the rule you will need to confirm your decision in a confirmation message box

prompt.
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